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Resumo 

O presente relatório insere-se no âmbito do estágio “Implementação do QGIS/QField como 
ferramenta de apoio à reflorestação no Sul da Bahia, Brasil”, realizado com a colaboração do 
Fundo Ambiental Sul Baiano (FASB) e da NGPTA Lda. A investigação centrou-se na criação 
e implementação de um sistema de informação geográfica (SIG) integrado, combinando o 
QGIS e o QField, como suporte à gestão de projetos de reflorestação na Mata Atlântica. Este 
sistema foi concebido para digitalizar, organizar e analisar dados geoespaciais, 
proporcionando ferramentas de apoio à monitorização, planeamento e apresentação de 
resultados dos projetos ambientais. 

A Mata Atlântica, localizada na região sul da Bahia, é um dos biomas mais biodiversos e 
ameaçados do Brasil, enfrentando desafios significativos decorrentes da desflorestação e da 
degradação ambiental. Para mitigar esses impactos, o FASB tem implementado projetos 
voltados à recuperação florestal e ao desenvolvimento sustentável das comunidades locais. 
Nesse contexto, o uso de tecnologias SIG permitiu a criação de mapas geoespaciais 
detalhados, a coleta e a sincronização de dados em campo e a capacitação de equipas técnicas 
e comunidades envolvidas. 

A metodologia adotada baseou-se na configuração de uma plataforma desktop (QGIS) 
interligada ao aplicativo móvel QField para o trabalho em campo, integrando dados coletados 
por agricultores e comunidades indígenas. Foram realizadas formações práticas para facilitar 
o uso destas ferramentas, garantindo a participação ativa das comunidades na criação e 
atualização de dados geográficos. Além disso, os resultados destacaram-se pela elaboração de 
cartografia de alta qualidade, pelo fortalecimento da gestão ambiental e pela inclusão social 
através da "tecnologia social". 

Este projeto evidenciou o potencial do QGIS/QField para a gestão integrada de territórios e 
demonstrou a importância de abordagens colaborativas na conservação ambiental, 
contribuindo significativamente para os objetivos do FASB e para a preservação da 
biodiversidade da Mata Atlântica. 

Palavras-Chave: Sul da Bahia, Fundo Ambiental Sul Baiano, iNovaland, Mata 
Atlântica, New Generation Plantations, QField, QGIS 
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Abstract 

This report is part of the professional internship titled “Implementação do QGIS/QField como 
ferramenta de apoio à reflorestação no Sul da Bahia, Brasil” carried out in collaboration with 
the Fundo Ambiental Sul Baiano (FASB) and NGPTA Ltd. The research focused on the 
development and implementation of an integrated geographic information system (GIS), 
combining QGIS and QField, to support the management of reforestation projects in the 
Atlantic Forest. This system was designed to digitize, organize, and analyze geospatial data, 
providing tools to aid in monitoring, planning, and presenting the results of environmental 
initiatives. 

The Atlantic Forest, located in southern Bahia, is one of Brazil’s most biodiverse and 
endangered biomes, facing significant challenges from deforestation and environmental 
degradation. To address these issues, the FASB has been implementing projects focused on 
forest recovery and sustainable development of local communities. In this context, the use of 
GIS technologies enabled the creation of detailed geospatial maps, the collection and 
synchronization of field data, and the training of technical teams and involved communities. 

The methodology included configuring a desktop platform (QGIS) linked to the mobile 
application QField for fieldwork, integrating data collected by farmers and indigenous 
communities. Practical training sessions were conducted to facilitate the use of these tools, 
ensuring active community participation in creating and updating geographical data. 
Additionally, the results stood out for the production of high-quality cartography, the 
strengthening of environmental management, and social inclusion through "social 
technology." 

This project highlighted the potential of QGIS/QField for integrated land management and 
demonstrated the importance of collaborative approaches in environmental conservation, 
significantly contributing to the FASB’s objectives and the preservation of the Atlantic 
Forest’s biodiversity. 

 

Keywords:South of Bahia, Fundo Ambiental Sul Baiano, iNovaland, Mata Atlântica, New 
Generation Plantations, QField, QGIS 
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GLOSSÁRIO 
FASB - Fundo Ambiental Sul Baiano 

iNovaland® - é um grupo  internacional que trabalha no restauro florestal na América do Sul 
e na África Ocidental 

MRV - Monitorização, Relatório e Verificação 

NGPTA Lda - é a empresa que faz a assistência técnica do FASB, pertencente ao grupo 
iNovaland®, sediada em Portugal. O acrónimo NGPTA, é inspirado no projeto New 
Generation Plantations (NGP) da WWF e na ideia de constituição de uma unidade de 
assistência técnica (Technical Assistance - TA) 

Plugin - é um componente de software que adiciona funcionalidades adicionais a um 
programa principal. No contexto de software como o QGIS, um plugin é uma extensão que 
pode ser instalada para estender as capacidades do programa base. 

Projeto FASB - é um projeto financiado pelo FASB e executado em colaboração com 
agricultores, que gera relatórios específicos para cada iniciativa, envolvendo a interação direta 
com os agricultores 

Projeto QField - desenvolvido para uso móvel e remoto, é uma extensão do projeto SIG, 
permitindo trabalho de campo através de dispositivos móveis 

Projeto SIG - utiliza o aplicativo QGIS desktop para criar mapas digitais, com sistema online 
para organização e exportação de mapas 

QField - aplicação para dispositivos móveis (Android e iOS) que complementa o QGIS 

QGIS - (Quantum GIS) Sistema de Informação Geográfica (SIG) de código aberto usado para 
visualizar, analisar e editar dados espaciais 

UFSB - Universidade Federal do Sul da Bahia 

SRC - Sistema de Referência de Coordenadas  
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Introdução 

O estágio profissional intitulado “Implementação do QGIS/QField como ferramenta de apoio 
à Reflorestação no Sul da Bahia, Brasil” foi realizado no âmbito do FASB (Fundo Ambiental 
Sul Baiano). O objetivo foi desenvolver uma solução aplicada QGIS/QField para apoiar a 
gestão de projetos de reflorestação da Mata Atlântica. O sistema deverá permitir a 
digitalização de dados, a análise espacial e a criação e gestão de relatórios. 

Este estágio profissional destaca a importância da operacionalização de uma solução integrada 
SIG (Sistema de Informação Geográfica) que harmoniza ferramentas desktop, como o QGIS, 
com ferramentas de trabalho de campo, como o QField, proporcionando uma sincronização 
eficaz entre ambas. Esta abordagem permite uma gestão mais eficiente e abrangente dos 
projetos, otimizando a recolha, a análise e a gestão de dados em todo o processo. 

O QGIS/QField é uma ferramenta útil para o ordenamento do território, oferecendo uma 
abordagem robusta e eficiente para a gestão e análise de dados geoespaciais. Facilita a 
visualização, análise e modelagem integrada do ambiente natural e foi construído por 
profissionais com longa experiência nestes domínios de trabalho. Ao combinar 
funcionalidades avançadas de SIG com a mobilidade proporcionada pelo QField os 
utilizadores podem realizar levantamentos em campo, recolher dados e atualizar informações 
em tempo real, contribuindo assim para uma abordagem mais dinâmica no planeamento e na 
gestão do território. 

O Sul da Bahia é uma região localizada no Nordeste do Brasil que abrange 70 municípios do 
Estado da Bahia e que se estende por aproximadamente 53.000 km² (ver Figuras 1A e 1B). 
Apresenta uma diversidade de paisagens, incluindo espaços florestais, rurais, agrícolas e 
urbanos. É habitado por cerca de 1 milhão e 578 mil de pessoas. 

A iNovaland® é um grupo de empresas dedicadas ao investimento sustentável no restauro de 
paisagens, com foco na silvicultura, na agrofloresta, na agricultura inteligente para o clima e 
em iniciativas relacionadas com o sequestro de carbono em África e na América do Sul. O 
objetivo é regenerar paisagens degradadas, beneficiando pessoas, natureza e clima através da 
colaboração com comunidades e parceiros diversos. A NGPTA Lda, o ‘braço’ técnico, 
especializa-se no apoio prático a projetos sustentáveis, oferecendo expertise em restauro 
florestal e de paisagens, além de agricultura inteligente para o clima. Juntos, impulsionam 
soluções de alto impacto, positivas para a natureza e o empoderamento comunitário. O projeto 
FASB promove o restauro ambiental e o desenvolvimento comunitário. Em Atebubu, no 
Gana, a iNovaland® está envolvida em projetos que combinam agricultura sustentável e 
restauro florestal para beneficiar as comunidades locais e o ambiente. 

Este estágio profissional foi reconhecidamente importante e desejado pelo FASB e pela 
NGPTA Lda porque existia a necessidade de alguém com competência técnica adequada à 
implementação bem-sucedida da solução QGIS/QField em projetos já em funcionamento. 
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Figuras 01A e 01B - Localização do Estado da Bahia, Sul da Bahia e Porto Seguro (fonte: Secretaria de Cultura, Governo do Estado da 
Bahia) 

 

Território de Estudo 

Por todo o mundo, as formações florestais naturais estão a ser fragmentadas, comprometendo 
a biodiversidade de ecossistemas essenciais. Isso deve-se ao uso excessivo dos recursos 
naturais, resultando em consequências prejudiciais para a população. Diante da grave situação 
da Mata Atlântica, diversas leis foram criadas com o objetivo de proteger o bioma. A Lei da 
Política Nacional do Meio Ambiente (Lei nº 6.938/1981) e a Lei do Sistema Nacional de 
Unidades de Conservação (Lei nº 9.985/2000) estabelecem diretrizes para a proteção 
ambiental e a criação de Unidades de Conservação, respectivamente. As Unidades de 
Conservação desempenham um papel fundamental na conservação e preservação da Mata 
Atlântica, protegendo áreas de floresta nativa que abrigam cerca de 20 mil espécies vegetais 
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(35% das espécies existentes no Brasil, aproximadamente) e promovendo a conservação da 
biodiversidade. Além disso, a Lei da Mata Atlântica (Lei nº 11.428/2006) foi especificamente 
criada para regulamentar o uso e proteção das áreas remanescentes do bioma. O Código 
Florestal (Lei nº 12.651/2012) também desempenha um importante papel na gestão de áreas 
florestais, promovendo a conservação e o uso sustentável das florestas no Brasil.  

        Figura 02 - Mapa dos Biomas do Brasil (fontes: SOS Mata Atlântica, Atlas da Mata Atlântica 2021-2022) 
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Mata Atlântica 

A Mata Atlântica no Brasil (ver Figura 2), outrora um manto verde que cobria mais de 130 
milhões de hectares em 17 estados brasileiros, é atualmente um dos biomas mais ameaçados 
do Brasil, ocupando apenas 12,4% da sua cobertura original, segundo dados do Ministério do 
Meio Ambiente (MMA, visitado em 2024). Esta degradação teve início com a colonização 
portuguesa e foi agravada pelo desenvolvimento regional. Estas ações humanas colocaram em 
risco as populações tradicionais e os povos originários, além de afetar as suas relações 
culturais e identitárias. 

A Mata Atlântica é um área crítica de biodiversidade, abrigando inúmeras espécies. Contudo, 
está gravemente ameaçada pelo crescente desflorestamento. A Bahia, por exemplo, está entre 
os estados que mais reduziram áreas naturais. O desflorestamento contínuo afeta a 
biodiversidade, a qualidade da água e contribui para as alterações climáticas. Segundo o 
relatório da SOS Mata Atlântica, entre 2019 e 2020 a Bahia perdeu 78.289 hectares de Mata 
Atlântica (SOS Mata Atlântica, 2020). 

A compreensão histórica da relação do ser humano com a Mata Atlântica é crucial, revelando 
práticas insustentáveis desde a colonização. A exploração predatória dos recursos da Mata 
Atlântica teve início com a colonização portuguesa, quando o Pau-Brasil (Caesalpinia 
echinata) se tornou um dos principais produtos de exportação (Oliveira, 2007). 
Posteriormente, a cana-de-açúcar (Saccharum sp.), com seus engenhos e monoculturas, 
devastou extensas áreas da floresta (Oliveira, 2007).  

No século XIX, a introdução do cacau (Theobroma cacao) na economia baiana impulsionou 
um novo ciclo de desmatamento. A busca por terras férteis para o cultivo do cacau levou à 
devastação de grandes áreas da Mata Atlântica, com impactos negativos para os povos 
indígenas e comunidades tradicionais que dependiam da floresta para a sua subsistência 
(MAPBIOMAS, 2023). 

Nas últimas décadas do século XX e início do XXI, observou-se a expansão das plantações de 
eucalipto (Eucalyptus sp.), impulsionada pelas empresas de papel e celulose. A conversão de 
pastagens em eucaliptais alterou significativamente a paisagem natural, contribuindo para a 
perda de biodiversidade e a degradação do solo (Freitas, s.d.). 

O turismo também se consolidou como uma importante atividade económica na região, mas 
nem sempre de forma sustentável. O turismo predatório, com infraestruturas inadequadas e 
falta de planeamento, gera diversos impactos negativos, como a poluição da água e do ar, a 
perda de habitat natural e a descaracterização cultural das comunidades locais (Araujo & 
Abreu, 2021). 

Leis como a Lei da Mata Atlântica (Lei nº 11.428/2006) e o Código Florestal (Lei nº 
12.651/2012) são fundamentais para a proteção e recuperação desse bioma, mas a 
implementação eficaz dessas normas ainda enfrenta desafios (Brasil, 2006; Brasil, 2012). 
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Empresas e Projetos 
 

iNovaland® 

Figura 03 - Logo da iNovaland 

A iNovaland® (www.inovaland.earth) representa um grupo internacional do setor privado, 
especializado em gestão e investimento em restauro sustentável de paisagens, incluindo 
silvicultura, agrofloresta, agricultura inteligente para o clima e iniciativas de carbono na 
América do Sul e África. 

A iNovaland integra: 

●​ iNovaland® - marca que identifica todo o grupo. 

●​ iNovaland Investments Ltd - responsável pela gestão dos fundos do FASB. 

●​ NGPTA Lda - responsável pela assistência técnica do FASB 

Figura 04 - Logos da iNovaland e NGPTA 

A iNovaland® promove o desenvolvimento de projetos escaláveis, a mobilização de fundos, o 
fornecimento de desenvolvimento de negócios, a gestão financeira e serviços contratuais.  
Estes serviços são adaptados às necessidades e aspirações de investidores, promotores de 
projetos e comunidades. O foco está em proporcionar benefícios máximos e impacto para o 
maior número de pessoas possíveis, apoiar a monitorização transparente e a divulgação de 
resultados sociais e ambientais. A iNovaland® fornece uma plataforma para o FASB 
compartilhar informações sobre seus projetos e atividades, além de facilitar a colaboração 
com outras organizações que trabalham na região. 
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NGPTA Lda  

A NGPTA é a unidade de assistência técnica da iNovaland® que transforma ideias em 
realidades. Atuando no terreno em paisagens florestais, apoia projetos novos ou em fase 
inicial de elevado impacto, que proporcionam benefícios duradouros para as pessoas, a 
natureza e o clima. 

Fornece suporte técnico em restauro sustentável de florestas e paisagens, e em agricultura 
regenerativa para o clima. A assistência técnica abrange desde a coordenação de diálogos 
multissetoriais até à monitorização da biodiversidade e dos impactos sociais, e o 
fortalecimento da capacidade de pequenos agricultores, líderes, empresas locais e 
organizações comunitárias. 

A NGPTA Lda, foi constituída em Maio de 2020 e o seu nome é um acrónimo inspirado no 
projeto New Generation Plantations (NGP) da WWF e na ideia de constituição de uma 
unidade técnica (Technical Assistance - TA). A empresa tem dois sócios fundadores: Luís 
Neves Silva (Universidade Técnica de Lisboa, Instituto Superior de Agronomia, Licenciatura 
em Engenharia Florestal, Gestão de Recursos Naturais) e Andrew Heald (Bangor University, 
Environmental Studies, Environmental Studies / Llysfasi College, University Certificate, 
Agriculture Certificate, Agriculture). 

Atualmente, a NGPTA Lda desenvolve projetos na África Ocidental (Gana) e na América do 
Sul (Brasil). Todos os projetos são co-projetados e co-implementados com as comunidades 
locais, em colaboração mais de perto com vários parceiros, incluindo organizações da 
sociedade civil, empresas privadas, agências governamentais e doadores internacionais. A 
envolver-se ativamente no terreno em paisagens florestais, apoia projetos novos ou em fase 
inicial de elevado impacto que proporcionam benefícios duradouros para as pessoas, a 
natureza e o clima. 

 

Gana (Atebubu and Wiase Forest Landscape Restoration Project) 

O "Atebubu and Wiase Forest Landscape Restoration Project" é uma iniciativa para o restauro 
de paisagens florestais degradadas na região de Atebubu, no Gana. Este projeto, que começou 
em junho de 2021 com um investimento de 7,5 milhões de euros, tem como objetivo 
transformar 8.280 hectares de terras degradadas num "Laboratório Vivo" para demonstrar a 
resiliência comunitária e ecológica através de práticas de restauro sustentável. Até agora, o 
projeto já recuperou 3.841 hectares, plantou 4.235.523 árvores, beneficiou mais de 2.500 
pessoas e treinou 2.526 indivíduos em técnicas sustentáveis de uso do solo (NGPTA Lda, 
2024). 
As estratégias de restauração adotadas incluem a agroflorestação, que combina árvores e 
culturas agrícolas para melhorar a produtividade do solo e a biodiversidade, o reflorestamento 
com espécies nativas e a capacitação dos agricultores e moradores locais. A iniciativa é uma 
colaboração entre o governo do Gana, ONGs, instituições académicas e comunidades locais, 
garantindo uma abordagem holística e inclusiva. 

16 



 

Os benefícios a longo prazo esperados incluem uma maior resiliência climática, a melhoria da 
biodiversidade e o desenvolvimento sustentável das comunidades locais, com a criação de 
empregos verdes e a promoção de práticas agrícolas sustentáveis. O projeto serve como um 
modelo inspirador para iniciativas semelhantes em outras regiões. 
A solução integrada QGIS/QField implementada no "Atebubu and Wiase Forest Landscape 
Restoration Project" funciona de maneira colaborativa com as comunidades locais. Membros 
da comunidade são treinados no uso de QField para recolher dados no campo. As 
comunidades registam informações sobre plantações e condições do solo usando dispositivos 
móveis. Os dados são recolhidos e atualizados regularmente em campo, recorrendo ao QField 
são depois sincronizados com o QGIS. Relatórios e mapas são produzidos regularmente e os 
progressos são compartilhados dentro da organização. 

 

FASB (Fundo Ambiental Sul Baiano) 

O Fundo Ambiental Sul Baiano (FASB) é um 
programa dedicado à proteção e preservação 
do meio ambiente na região Sul da Bahia. Os 
seus principais objetivos incluem a  
conservação dos recursos naturais, a promoção do desenvolvimento sustentável e a 
conscienciação ambiental da comunidade local. O FASB desempenha um papel crucial na 
comunidade, envolvendo-se em projetos e iniciativas que visam mitigar os impactos 
ambientais, promover práticas sustentáveis e incentivar a participação ativa dos cidadãos na 
preservação do meio ambiente. 
A estrutura do FASB conta com uma equipa local dedicada, composta por profissionais como 
Breno Neves, Agente de Campo; Neuza de Jesus Souza, Agente de Campo; e Raony Palicer 
de Lima, Coordenador do FASB. A direção é liderada por Márcio Braga, Diretor da 
iNovaland Brasil. Essa equipa atua de maneira organizada, coordenando esforços em um 
território vasto e diverso, assegurando a implementação eficaz das iniciativas do FASB. 
O FASB resulta de uma parceria entre a NGPTA Lda, o Fórum Florestal da Bahia e a KIRKBI 
(www.kirkbi.com). A NGPTA é a empresa que presta apoio técnico ao programa FASB.  
Fundado em 2021, o FASB já apoiou 45 projetos com um investimento de 3 milhões de euros, 
financiando e prestando apoio técnico a projetos socioambientais no Sul da Bahia. Os projetos 
apoiados são desenvolvidos por instituições locais, como associações de agricultores 
familiares e povos indígenas. Com foco na restauração florestal, agroecologia, produção 
sustentável e outras iniciativas verdes, o FASB contribui para a preservação da biodiversidade 
da Mata Atlântica, ao mesmo tempo que impulsiona o desenvolvimento socioeconômico 
local. 
A KIRKBI A/S é a holding privada da família Kirk Kristiansen, proprietária de 75% do 
Grupo LEGO, comprometida com investimentos de longo prazo e desenvolvimento 
sustentável. A empresa apoia o Fundo Ambiental Sul Baiano (FASB) através de parcerias 
estratégicas que visam a preservação da Mata Atlântica e o desenvolvimento socioambiental 
no sul da Bahia, colaborando com entidades como a iNovaland e a NGPTA na gestão e 
implementação de projetos sustentáveis na região. 
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Figuras 05A, 05B e 05C - Mapas com a localização de três projetos financiados pelo FASB (Fontes: Secretaria de Cultura, Governo do 
Estado da Bahia e Registos do FASB) 

Um projeto submetido ao FASB é uma iniciativa que visa promover ações sustentáveis e de 
impacto positivo, como a restauração ambiental e o desenvolvimento socioeconómico. Para 
ser submetido, o responsável deve apresentar uma proposta detalhada que inclua os objetivos, 
o cronograma de execução, os recursos necessários e os indicadores de sucesso. Os critérios 
de elegibilidade incluem o alinhamento com as metas do FASB, a viabilidade técnica e 
financeira, e o potencial de benefício à comunidade local ou ao meio ambiente. A aceitação 
do projeto depende de uma avaliação criteriosa, e o financiamento é concedido conforme a 
adequação aos critérios estabelecidos, com prestação de contas periódicas e transparência no 
uso dos recursos. 

Os projetos FASB são focados em três principais áreas: i. Agricultura Sustentável, ii. 
Reflorestação e iii. Projetos Sociais. A Agricultura Sustentável promove práticas agrícolas 
que respeitam o meio ambiente, buscando melhorar a produtividade sem comprometer os 
recursos naturais. Os projetos de Reflorestação têm como objetivo restaurar áreas degradadas, 
contribuindo para a conservação da biodiversidade e a recuperação da Mata Atlântica. Os 
Projetos Sociais visam o desenvolvimento das comunidades locais, fortalecendo a economia 
rural e promovendo a inclusão social. A Tabela 1 apresenta a distribuição dessas iniciativas 
por município, número de projetos e área ocupada em hectares, destacando o alcance das 
ações realizadas até o final de 2023. 

 

18 



 

Distribuição de Projetos financiados pelo FASB por Município, por Tipo e por Área, até ao 
final de 2023 

Municípios Número de Projetos Tipo de Projeto Área (hectares) 

Caravelas 5 - Reflorestação 
- Proj. Sociais 

130 

Eunápolis 6 - Agricultura 
Sustentável 

- Reflorestação 
- Proj. Sociais 

190 
 

Itagimirim 3 - Reflorestação 60 

Porto Seguro 7 - Agricultura 
Sustentável 

- Reflorestação 
- Proj. Sociais 

250 

Prado 4 - Reflorestação 
- Proj. Sociais 

110 

Santa Cruz Cabrália 6 - Agricultura 
Sustentável 

- Reflorestação 
- Proj. Sociais 

160 

Teixeira de Freitas 14 - Agricultura 
- Sustentável 

- Reflorestação 
- Proj. Sociais 

340 

Tabela 01 - Distribuição de Projetos financiados pelo FASB por Município, Tipo e Área (ha) 

QGIS/QField 

O QGIS (www.qgis.org) é um Sistema de Informação Geográfica (SIG) de código aberto 
amplamente utilizado para visualização, análise e edição de dados espaciais. Oferece uma 
plataforma para o desenvolvimento de projetos SIG, permitindo a organização, visualização e 
exportação cartográfica de forma eficiente. 
O funcionamento do QGIS baseia-se em camadas de informação geográfica. Os utilizadores 
podem adicionar camadas que representam diferentes tipos de dados, como mapas de base, 
imagens de satélite, dados em formatos vetoriais e raster. Podem realizar uma variedade de 
operações, desde a simples visualização até à análise espacial avançada, como a interpolação, 
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a análise de proximidade e a modelação de terrenos, entre muitos outros. Além disso, o QGIS 
suporta uma ampla gama de plugins que adicionam funcionalidades,  sempre que necessário. 
O QField (www.qfield.org) complementa o QGIS, sendo uma aplicação concebida para ser 
instalada em dispositivos móveis e projetada para o trabalho em campo, que oferece 
funcionalidades adicionais de visualização, recolha e análise de dados geográficos de forma 
remota, online e offline (QField, 2024). 
O QField permite aos utilizadores captar dados geoespaciais diretamente em dispositivos 
móveis, como smartphones e tablets, quando estão no campo, sem a estrita necessidade de 
conexão com a internet. Com o QField, os utilizadores podem carregar mapas e camadas 
preparadas no QGIS, para posterior uso offline, fazer edição dos dados em campo e 
sincronizar as alterações de volta para o QGIS quando estiverem online novamente. 
Optou-se pela versão gratuita do QField, que já oferece muitas funcionalidades. Além disso, 
foi utilizado o QField Cloud, que facilita a sincronização de dados entre diferentes 
dispositivos. O QField Cloud permite que as equipas compartilhem e acessem informações 
em tempo real, otimizando a colaboração e a atualização dos dados coletados. Isso é 
especialmente útil para projetos que envolvem várias pessoas, pois todos podem ter acesso às 
informações mais recentes, independentemente de sua localização. 
Para garantir uma sincronização eficiente dos dados coletados em campo com o QGIS, 
também foi empregue o plugin QField Sync. Este plugin permite que as alterações feitas em 
campo sejam facilmente transferidas de volta para o QGIS assim que a conexão à internet for 
restabelecida. Isso assegura que todas as informações estejam atualizadas e organizadas, 
facilitando a análise posterior e a tomada de decisões com base em dados precisos e em tempo 
real (QField, 2024). 
No entanto, dois desafios principais surgiram com a implementação do QGIS/QField: a 
exatidão das coordenadas geográficas capturadas em campo e a sincronização dos dados entre 
os dispositivos móveis e o sistema de escritório. Durante os testes em áreas remotas, 
especialmente em regiões de floresta densa, a captura de coordenadas geográficas apresentou 
problemas de exatidão de até 2 metros, uma vez que os dispositivos móveis tinham 
dificuldades em obter leituras exatas devido à falta de conectividade e a interferências 
ambientais. Para mitigar essa fragilidade decidiu-se reduzir a quantidade de dados 
sincronizados em campo, otimizando o desempenho offline, e realizar ajustes manuais nas 
coordenadas no escritório, assegurando a correção dos dados. 
Além disso, a sincronização entre o QField e o QGIS, embora facilitada pelo plugin QField 
Sync, apresentou algumas limitações em ambientes com conectividade limitada. Foi 
necessário garantir que a configuração das camadas de dados fosse adequada para um fluxo 
de sincronização eficiente e que as edições realizadas no campo pudessem ser integradas ao 
QGIS sem perda de dados ou inconsistências. Esse processo exigiu a implementação de 
práticas de verificação de qualidade após a importação dos dados, como a revisão manual de 
polígonos e correção de sobreposições. 
Ao empregar esse conjunto de soluções com ajustes estratégicos, a equipa foi capaz de 
contornar as limitações técnicas e garantir a continuidade das operações de coleta e análise de 
dados geoespaciais, assegurando a exatidão e confiabilidade das informações utilizadas no 
projeto FASB. 
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Objetivos 

Os objetivos estabelecem uma base abrangente para o estágio, abordando quer os aspectos 
técnicos, quer os sociais e práticos da implementação do sistema de QGIS/QField. Refletem 
um compromisso entre promover a eficácia e o sucesso dos projetos em conjunto, em linha 
com os objetivos de desenvolvimento sustentável do FASB e da NGPTA Lda. 

 Detalhadamente, no início do estágio profissional, estabeleceram-se os seguintes objetivos: 

1.​ Desenvolver a arquitetura da aplicação SIG e a estrutura de organização, 
armazenamento, análise e apresentação de resultados. 

2.​ Concretizar a aplicação desktop (QGIS): 

a.​ Configurar o projeto FASB no QGIS, reunindo os polígonos dos projetos 
FASB numa visualização geoespacial única; 

b.​ Criar uma tabela de atributos que servirá como base para o armazenamento e 
organização das informações dos projetos do FASB; 

c.​ Preencher as informações dos projetos do FASB na tabela de atributos. 

3.​ Implementar a aplicação field work (QField): 

a.​ Configurar o sistema online para uso remoto em dispositivos diversos. 

4.​ Formar os utilizadores da aplicação SIG: 

a.​ Capacitar a equipa local do FASB; 

b.​ Ensinar os agricultores e indígenas como introduzir informação no sistema. 
(Google Earth) 

5.​ Contribuir para a funcionalidade da aplicação SIG: 

a.​ Manter o sistema operacional; 

b.​ Melhorar progressivamente a performance do QGIS/QField para o FASB. 

6.​ Resultados ao longo do tempo: 

a.​ Exportar cartografia para apresentar as atividades e o desenvolvimento dos 
projetos do FASB à NGPTA Lda. 
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Estratégia 
A abordagem estratégica adotada para o estágio baseou-se na aplicação de um processo 
estruturado para garantir a implementação eficaz e eficiente do sistema QGIS/QField no 
contexto dos projetos do FASB. As atividades foram organizadas em torno de três eixos 
principais: a configuração técnica do SIG, a integração do trabalho de campo com o QField e 
a capacitação dos utilizadores finais, incluindo a equipa local e as comunidades envolvidas. 

1.​  Desenvolvimento da Arquitetura do SIG: A estratégia inicial envolveu a definição 
da arquitetura do Sistema de Informação Geográfica (SIG) para organizar e integrar os 
dados geoespaciais no âmbito dos projetos do FASB. Optou-se pelo QGIS como 
plataforma principal devido à sua flexibilidade e capacidade robusta de 
geoprocessamento. Esta etapa garantiu a criação de uma estrutura padronizada com 
camadas organizadas de acordo com os critérios de Monitorização, Relatório e 
Verificação (MRV), facilitando as etapas subsequentes de implementação e operação 
do sistema. 

2.​ Configuração do Projeto FASB no QGIS: A organização e integração dos dados 
geoespaciais no FASB envolveu a recepção, importação e estruturação de polígonos 
provenientes de várias fontes. Optou-se pelo QGIS devido à sua flexibilidade e 
robustez em geoprocessamento, o que facilita a representação integrada e acessível 
dos projetos do FASB. O fluxo de configuração começou com a importação das 
camadas, seguido pela criação de uma tabela de atributos, garantindo que todas as 
informações relevantes fossem organizadas e facilmente atualizáveis. O SRC (Sistema 
de Referência de Coordenadas) é essencial para a representação geográfica correta. No 
Brasil, o SIRGAS 2000 é o sistema mais utilizado, garantindo a padronização das 
coordenadas no território brasileiro. Para o FASB, o sistema adotado é o SIRGAS 
2000 / UTM zone 24S, identificado pelo EPSG:31984, que permite a correta 
localização e análise espacial dos dados geográficos na Bahia. 

3.​ Implementação da Aplicação de Campo (QField): O QField foi implementado 
como parte da estratégia de integração entre trabalho de campo e sistema desktop, 
garantindo a recolha e atualização de dados em tempo real. Valorizaram-se as 
funcionalidades de sincronização eficiente entre QGIS e QField, permitindo uma 
transição fiável dos dados entre dispositivos móveis e o projecto FASB no QGIS (fig. 
15). Os testes de campo foram realizados para validar a exatidão e funcionalidade do 
sistema, com ajustes sendo feitos conforme necessário para maximizar a usabilidade 
em diferentes condições de trabalho (fig. 16). 

4.​ Capacitação e Formação dos Utilizadores: O processo de formação foi conduzido 
de forma gradual e colaborativa, começando com a equipa local do FASB e 
expandindo depois para os agricultores e comunidades indígenas. A metodologia de 
ensino focou-se em práticas de aprendizagem ativa, com os participantes diretamente 
envolvidos na criação e manipulação de dados geoespaciais. Sessões práticas com o 
uso de ferramentas como o Google Earth e o QGIS foram organizadas para garantir a 
autonomia dos utilizadores no uso das tecnologias apresentadas (fig. 17). 

5.​ Manutenção e Atualização dos Dados: Um dos aspectos centrais da estratégia de 
intervenção foi a criação de um sistema sustentável de manutenção e atualização 
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contínua dos dados geoespaciais. Tal foi alcançado por meio da sincronização regular 
com o QField, garantindo que todos os dispositivos tivessem acesso aos dados mais 
recentes e permitindo a coleta de dados em tempo real no campo (fig. 18). O uso de 
ferramentas específicas, como o Verificador de Topologia no QGIS, assegurou a 
integridade e a exatidão dos dados ao longo do tempo (fig.19). 
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Tarefas executadas 
1.​ Planeamento e Estruturação do SIG: 

1.1.​  Definição do QGIS como Plataforma Principal:  
Escolha do QGIS pela sua robustez e integração com o QField para trabalho de 
campo. 

1.2.​ Organização das Camadas:  
Divisão das informações por temas (ex.: Limites de Projetos, Áreas de 
Intervenção, Municipios, Estágios de Plantio, Tipo de Projeto). 

1.3.​ Criação da Tabela de Atributos:  
Estruturação de campos essenciais (ID do projeto, Nome, Área, Relatórios). 

1.4.​ Preparação para Exportação ao QField:  
Configuração inicial com o plugin QField Sync para sincronização eficiente 
dos dados em dispositivos móveis. 

2.​ Configuração do Projeto FASB no QGIS 
2.1.​ Receção e Importação de Polígonos:​

Foram recebidos polígonos dos projetos apoiados pelo FASB através de e-mail, 
em diversos formatos, nomeadamente shapefiles (.shp), KML e KMZ. Estes 
ficheiros continham as informações geoespaciais de várias áreas de intervenção 
dos projetos. A importação para o QGIS foi realizada utilizando a ferramenta 
“Adicionar Camada Vetorial” (Layer > Add Layer > Add Vector Layer). Este 
processo permitiu que todos os polígonos fossem carregados diretamente da 
pasta onde os ficheiros foram armazenados, assegurando a integridade dos 
dados geoespaciais. 

 

 

 

 

 

 

 

 

 

 

 

 

Figura 06  - Ferramenta “Adicionar Camada Vetorial” (Layer > Add Layer > Add Vector Layer) 
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2.2.​ Estruturação de Dados Geoespaciais:​
Após a importação dos polígonos, procedeu-se à organização e estruturação 
dos mesmos no QGIS. Através das ferramentas “Juntar Camadas Vetoriais” 
(Vector > Data Management Tools > Merge Vector Layers) e “União” (Vector 
> Geoprocessing Tools > Union), os polígonos foram combinados numa única 
camada, agrupando-os de acordo com o número de identificação do projeto 
(ex: FASB123456_654321). Esta etapa permitiu a consolidação das 
informações e facilitou a análise e visualização dos dados de todos os projetos 
FASB numa só camada.    

                                                                                 

                                                             ​
 

 

                                   

                                       Figura 07 - Ferramenta “União” (Vector > Geoprocessing Tools > Union)        

Para melhorar a visualização dos dados, foram configuradas as propriedades de 
cada camada através da ferramenta “Propriedades da Camada” (Layer 
Properties). Ajustaram-se cores, estilos e transparência, permitindo uma 
distinção clara entre os diferentes polígonos e melhorando a leitura dos dados. 
Além disso, foi ativada a sincronização com o QField para dispositivos móveis 
através da opção (Layer Properties > QField > General Settings), permitindo o 
acesso aos dados em campo. Nos anexos, estão disponíveis os mapas, sendo 
que as Figuras 3A, 3B e 3C apresentadas acima são exemplos que ilustram de 
forma eficaz o que foi exposto neste texto. 

2.3.​ Criação de Tabela de Atributos:​
Com base nos critérios de Monitorização, Relatório e Verificação (MRV) 
estabelecidos pela iNovaland, foi criada uma tabela de atributos para cada 
camada de polígonos. Essa tabela inclui campos como identificação do projeto, 
nome do projeto, área, município, tipo de projeto, descrição, identificação de 
polígonos, relatório técnico, relatório financeiro e estágio do projeto, entre 
outros. Utilizou-se a ferramenta "Calculadora de Campo" para preencher 
automaticamente alguns campos por meio de expressões de cálculo, enquanto 
outros campos foram preenchidos manualmente com informações extraídas 
dos relatórios técnicos disponíveis. Esta tabela de atributos funciona como uma 
base de dados para a organização e consulta das informações associadas a cada 
projeto. Nos anexos, está disponível a estrutura da tabela de atributos (Layer 
Properties > Fields), permitindo uma visão detalhada da configuração dos 
dados. 
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3.​ Implementação da Aplicação Field Work (QField) 

3.1.​ Configuração do QField Cloud:​
Para garantir a sincronização e a atualização em 
tempo real dos dados entre o QGIS e os 
dispositivos móveis, foi necessário criar contas 
no QField Cloud para todos os colaboradores do 
FASB. O processo foi iniciado no site 
“app.qfield.cloud”, onde cada colaborador foi 
convidado a juntar-se ao projeto. Esta 
configuração permitiu que todos os utilizadores 
tivessem acesso ao projeto e aos dados 
diretamente nos seus dispositivos móveis, 
garantindo a mobilidade e a eficiência na coleta 
e edição de dados em campo. 

 

 

                                             

                                                                                                        Figura 08 - Registo no QfieldCloud 

3.2.​ Exportação e Sincronização do Projeto:​
No QGIS, o projeto foi preparado para ser exportado para o QField utilizando 
o plugin “QField Sync”.                                                                                                 

Este plugin foi configurado para otimizar os dados, simplificando as 
geometrias e selecionando apenas as camadas e atributos necessários para o 
trabalho de campo. Através da opção “Comprimir para o QField” e 
“Sincronizar o Projeto Cloud Atual”, o projeto foi exportado e compactado 
num formato compatível com o QField, sendo então enviado para o QField 
Cloud. A partir daí, os colaboradores puderam descarregar o projeto 
diretamente para os seus dispositivos móveis e utilizá-lo no terreno.   

Figura 09 - Vista Geral dos Projetos 
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3.3.​ Testes em Campo:​
Foram realizados diversos testes de campo para verificar o correto 
funcionamento da aplicação QField nos dispositivos móveis. Estes testes 
incluíram a captura de novos dados, como a criação de novos polígonos em 
campo, edição de polígonos existentes e a verificação da exatidão das 
coordenadas GPS. Os testes foram conduzidos tanto no exterior (espaços 
abertos) como no interior, para simular diferentes condições de trabalho. Com 
base no feedback da equipa local do FASB, foram feitos ajustes e otimizações 
para melhorar a usabilidade e funcionalidade do sistema no terreno. Durante os 
testes, a equipa encontrou alguns problemas: dificuldades em captar GPS em 
áreas com muitas árvores e lentidão no carregamento de camadas em 
dispositivos mais antigos. Para solucionar esses problemas, foram adotadas as 
seguintes medidas: i. ajustes no GPS, aumentando a frequência de 
atualizações, o que ajudou a melhorar a exatidão em áreas densas, como 
florestas; ii. simplificação de camadas, a complexidade das camadas de dados 
foi reduzida ao registrar os detalhes adicionais em anotações separadas e 
inserir essas informações na tabela de atributos apenas após o retorno ao 
escritório. Isso permitiu um carregamento mais rápido e eficiente no campo. 

3.4.​ Sessões de Formação:​
Foram organizadas e conduzidas várias sessões de formação, presenciais e 
online, destinadas à equipa local do FASB. Os participantes foram treinados no 
uso do QGIS e do QField, desde a criação e edição de projetos até à utilização 
das ferramentas de geoprocessamento e verificação de topologia. Além disso, 
foi demonstrado como criar camadas, importar dados, editar polígonos, 
configurar o sistema de referência de coordenadas (SRC) e utilizar plugins 
como o QField Sync e o QuickMap Services para integração de mapas 
disponíveis online. As formações incluíram exercícios práticos (Anexo I), onde 
os participantes puderam testar o que aprenderam em situações reais de 
projeto. 
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Figura 10 - Aula (Eunápolis 16/04/2024) de Capacitação e Formação (fotografia de Nicolau Silva) 

 

4.​ Capacitação de Agricultores e Comunidades Indígenas 

4.1.​ Formação Prática em Google Earth:​
Agricultores e membros de comunidades indígenas foram capacitados para 
utilizar o Google Earth na criação e envio de polígonos geoespaciais. Durante 
as aulas práticas foi demonstrado como criar polígonos no Google Earth, salvar 
os arquivos em formato KML/KMZ e enviá-los via e-mail para posterior 
integração no QGIS. As sessões incluíram exercícios práticos onde os 
participantes criaram e partilharam os seus próprios polígonos, recebendo 
feedback e suporte técnico durante o processo. Esta capacitação teve como 
objetivo proporcionar autonomia às comunidades na criação de dados 
geográficos, fundamentais para o monitoramento dos projetos. 

 

5.​ Validação e Manutenção de Dados no QGIS 

5.1.​ Verificador de Topologia:​
Para assegurar a integridade dos dados geoespaciais e evitar inconsistências, 
utilizou-se o “Painel do Verificador de Topologia” (Vector > Topology 
Checker) no QGIS. Foram configuradas regras topológicas como “Não devem 
ter duplicados”, “Não devem ter geometrias inválidas” e “Não se devem 
sobrepor” para garantir que os polígonos não se sobrepusessem e que todos os 
vértices estivessem corretamente conectados. Esta verificação ajudou a 
identificar e corrigir erros de sobreposição e lacunas entre polígonos. 
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5.2.​ Cálculo de Áreas:​
A área de cada polígono 
foi calculada utilizando a 
“Calculadora de Campos” 
(Attribute Table > Field 
Calculator) no QGIS. Foi 
criado um campo 
específico para armazenar 
os valores de área, e a 
expressão “$area” foi 
utilizada para calcular 
automaticamente a área de 
cada polígono. Esta 
informação foi 
fundamental para os 
relatórios de 
monitorização dos projetos.    Figura 11 - Ferramenta “Calculadora de Campos” 

5.3.​ Manutenção e Atualização de Dados:​
Realizou-se uma manutenção contínua dos dados geoespaciais, incluindo a 
adição de novos polígonos e a atualização de informações nos atributos. 
Assegurou-se também que a sincronização regular com o QField Cloud 
estivesse ativa, para que todos os dispositivos móveis tivessem acesso aos 
dados mais recentes e atualizados, permitindo a coleta eficiente e precisa de 
novos dados em campo. 

 

6.​ Outras Tarefas Relevantes 

6.1.​ Instalação e Atualização de Ferramentas:​
Garantiu-se que o QGIS estivesse sempre atualizado na versão LTR (Long 
Term Release), assegurando estabilidade e compatibilidade com os plugins 
utilizados frequentemente. Foram instalados e configurados plugins como o 
QField Sync, QuickMap Services e outros necessários para o desenvolvimento 
do projeto. 

6.2.​ Preparação e Ajuste de Layouts de Impressão:​
Ajustaram-se os layouts de impressão no QGIS, criando mapas com qualidade 
cartográfica profissional, que foram posteriormente exportados para 
apresentação de relatórios e resultados das atividades e desenvolvimento dos 
projetos FASB à NGPTA Lda. A personalização dos layouts incluiu a adição 
de legendas, escalas e outros elementos necessários para uma comunicação 
clara dos dados geoespaciais. 
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Figura 12 - Aldeia 
Kai, antes de 
sairmos para o 
reconhecimento da 
Área (02/05/2024) 
(fotografia do 
FASB) 

 
Resultados 

Arquitetura da Aplicação SIG Desenvolvida​
O projeto FASB foi configurado no QGIS, resultando em uma visualização geoespacial 
unificada dos polígonos dos projetos. A aplicação contém uma tabela de atributos estruturada 
com base nos critérios de Monitorização, Relatório e Verificação (MRV) da iNovaland. Essa 
tabela inclui campos para identificação do projeto, nome, área em metros quadrados e 
hectares, municípios, tipo de projeto, estado dos relatórios técnico e financeiro, estágio do 
projeto, número de árvores plantadas, validade das informações, parcerias e outros detalhes 
relevantes. Todos os dados foram organizados e estão prontos para uso e consulta. 

Implementação do QField​
O sistema QField foi totalmente configurado, garantindo sincronização ativa entre 
dispositivos móveis e desktop. Todos os colaboradores do FASB possuem contas ativas no 
QField Cloud, permitindo acesso contínuo ao projeto e aos dados em campo. A aplicação foi 
testada em diversas condições de trabalho, ajustando-se conforme necessário para garantir a 
sua funcionalidade. 

Capacitação dos Usuários​
Os usuários envolvidos nos projetos, incluindo agricultores e comunidades indígenas, foram 
capacitados no uso das ferramentas QGIS e QField. As sessões de formação incluiram 
instruções práticas sobre criação e edição de projetos, utilização de ferramentas de 
geoprocessamento e integração de dados. 
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Validação e Manutenção de Dados​
Para garantir a integridade dos dados geoespaciais, foi utilizado o "Painel do Verificador de 
Topologia" no QGIS, configurando regras para evitar duplicidades e geometrias inválidas. A 
área de cada polígono foi calculada usando a “Calculadora de Campos”, e a manutenção 
contínua dos dados foi assegurada através da sincronização regular com o QField Cloud, 
permitindo acesso atualizado e eficiente às informações. 

Cartografia Produzida​
As cartografias dos projetos FASB foram geradas com os dados organizados. Os layouts de 
impressão foram ajustados para garantir a qualidade cartográfica, incluindo legendas e 
escalas, adequados para relatórios e apresentações. 

Integração do Sistema de Campo e Escritório​
O processo de integração entre o QField, utilizado pelos técnicos de campo, e o Google Earth, 
utilizado pelos agricultores, foi concluído. Todos os polígonos foram combinados utilizando a 
ferramenta de gestão "Juntar Camadas Vetoriais", garantindo continuidade e sincronização 
dos dados. 

Método de Ensino Implementado​
As sessões presenciais e workshops práticos foram realizados com sucesso, assegurando um 
aprendizado completo e interativo para todos os participantes, com suporte contínuo da equipa 
responsável pelo projeto. 

 

 

 

 

 

 

 

 

 

 

 

Figura 13 - Reconhecimento da área da Aldeia Kai (Prado, Bahia) (02/05/2024)  junto a praia (fotografia do FASB) 
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O meu papel / trabalho 
No desenvolvimento do SIG para o FASB, comecei do zero, pois ao chegar ao Brasil, não 
havia nada em QGIS previamente implementado. Enfrentaram-se vários desafios práticos que 
exigiram a aplicação direta da estratégia em diferentes contextos. Abaixo, descrevem-se 
alguns exemplos concretos relacionados com a execução das tarefas e como essas atividades 
foram ajustadas para atender às necessidades do FASB. 

O processo de desenvolvimento da arquitetura da aplicação SIG foi uma tarefa que teve que 
ser feita rapidamente, pois a equipa do FASB estava a preparar-se para a chegada de novos 
projetos. O curto prazo imposto pela organização criou a necessidade de ser ágil, pelo que 
planear e executar foram ações que aconteceram quase simultaneamente. Decidiu-se adotar 
uma abordagem incremental, o que significa que à medida que os requisitos iam sendo 
definidos eram imediatamente aplicados. 

Por exemplo, enquanto se discutia como é que os polígonos deveriam ser organizados e 
apresentados, iniciou-se logo a configuração do projeto FASB no QGIS. O objetivo era criar 
uma visualização geoespacial única que reunisse todos os polígonos dos diferentes projetos, 
de forma integrada. Isso permitiu que se pudesse ajustar a estrutura do SIG ao mesmo tempo 
em que se avançava no preenchimento de dados e na preparação para o uso em campo. 

Por outro lado, aquando da importação dos polígonos que foram sendo enviados,  
identificou-se que algumas das informações estavam desorganizadas, com a sobreposição de 
polígonos em algumas áreas. 

Esses erros de sobreposição tornaram-se 
evidentes à medida que se combinavam os 
polígonos usando a ferramenta "União" no QGIS. 
Esse problema ocorreu porque alguns dados 
haviam sido registrados mais do que uma vez ou 
com coordenadas com ligeiras incorreções. Para 
corrigir, foi necessária uma revisão manual de 
cada polígono e a correção das áreas sobrepostas. 
Essa tarefa levou cerca de 2 a 3 semanas e 
revelou a importância de se realizar uma 
verificação de qualidade logo após a importação 
inicial dos dados, o que não havia sido previsto 
inicialmente.                                                              Figura 14 - Exemplo de Polígonos com sobreposição   

 

 

 

32 



 

Durante o preenchimento da tabela de atributos, tornou-se evidente que algumas informações 
estavam ausentes ou imprecisas, especialmente os relatórios financeiros e técnicos de 
determinados projetos. Isso exigiu consultar uma vez mais os relatórios de campo e os 
colaboradores para corrigir e complementar os dados na tabela. Foi necessário um esforço 
colaborativo, no qual se reuniram as informações diretamente das comunidades envolvidas, 
garantindo que cada campo fosse atualizado com exatidão. Esse processo levou de 3 a 4 
semanas e contou com a ajuda pontual da equipa local do FASB. No fim desse processo, a 
tabela foi completamente preenchida, o que facilitou o processo de geração de relatórios 
detalhados. 

Figura 15 - Tabela de Atributos Incompleta 

 

Outro exemplo relevante está relacionado com a sincronização dos dados entre o QGIS e o 
QField. Tratava-se de uma questão crítica, pois garantir a recolha e atualização de dados no 
campo era essencial para o sucesso do projeto. 

Durante os testes iniciais enfrentaram-se alguns problemas com a exatidão dos dados GPS em 
áreas mais remotas, onde a conectividade era limitada. Esses problemas foram 
particularmente críticos numa área de floresta densa, onde os dispositivos móveis não 
conseguiam capturar coordenadas com a exatidão necessária. Como solução, decidiu-se 
otimizar o uso dos dispositivos móveis, reduzindo a quantidade de dados sincronizados para 
facilitar o desempenho offline e realizando ajustes manuais no escritório. 

Numa ocasião particular, durante a recolha de dados numa comunidade indígena, foi 
necessária a criação de novos polígonos no local para mapear áreas de cultivo que haviam 
sido expandidas recentemente. No entanto, ao sincronizar entre o QField e QGIS os dados, 
percebemos que as novas áreas não haviam sido atualizadas corretamente no sistema desktop. 
O problema foi identificado como uma falha na sincronização, devido à instabilidade da rede 
no local. A solução foi realizar uma nova sincronização manual ao retornar à sede do projeto, 
garantindo que as informações recolhidas fossem integradas corretamente com o QGIS. 
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Figura 16 - Conjunto de elementos  do QGIS para o QField com avisos de erros 

Para além dos exemplos de natureza técnica, existem outros que não podem deixar de ser 
referidos e que são de natureza humana. Durante as sessões de formação, foi notado que 
muitos participantes, principalmente os mais idosos, apresentavam dificuldades em manipular 
as ferramentas de geoprocessamento e criar arquivos KML/KMZ de forma precisa. 

Para contornar essa situação, adotou-se uma estratégia colaborativa. Geralmente, os filhos ou 
netos dos agricultores e indígenas têm mais facilidade e familiaridade com as tecnologias 
digitais. Consequentemente, a solução foi envolvê-los de uma forma mais intensa, 
ensinando-os a usar as ferramentas, para que pudessem auxiliar os seus pais ou familiares na 
recolha e envio dos dados. Em algumas sessões práticas, enquanto os mais velhos 
acompanhavam o processo, os jovens criavam os polígonos no Google Earth e 
compartilhavam os arquivos corretamente formatados via e-mail. 

Essa abordagem não só facilitou a adoção da solução QGIS/QField, como também promoveu 
uma maior integração entre as gerações, com os mais jovens assumindo um papel ativo na 
recolha de dados e monitoramento dos projetos. Além disso, essa estratégia ajudou a garantir 
que os dados enviados eram mais rigorosos e entregues de forma mais rápida e eficiente, dado 
o domínio dos jovens sobre as ferramentas digitais. 
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Conclusões 
O estágio realizado teve um papel central na implementação do sistema QGIS/QField nos 
projetos de reflorestação do FASB, uma experiência enriquecedora que contribuiu 
significativamente para o sucesso dos projetos de reflorestação na região da Mata Atlântica, 
apoiados também pela NGPTA Lda. A minha principal responsabilidade foi configurar a 
aplicação QGIS, criando uma visualização geoespacial integrada dos projetos e implementar o 
QField para permitir o uso remoto no campo. Além disso, fui encarregado de treinar a equipa 
local, tarefa fundamental para assegurar a continuidade do uso das tecnologias 
implementadas. 

No entanto, a execução do estágio não esteve isenta de desafios, tendo alguns já sido descritos 
acima. Capacitar a equipa local a utilizar o QField revelou-se mais complexo do que o 
previsto, dado o nível de inexperiência dos utilizadores do SIG. Sessões de formação e 
exercícios práticos tiveram de ser adaptados e simplificados. Como alternativa, recorreu-se ao 
Google Earth, uma ferramenta mais intuitiva e acessível, para facilitar a criação e partilha de 
polígonos. Essa abordagem contribuiu para aumentar a participação ativa de agricultores e 
comunidades indígenas no processo. 

O uso do Google Earth evidenciou o conceito de "tecnologia social", pois permitiu que 
indivíduos com pouco conhecimento técnico contribuíssem ativamente para a recolha de 
dados. A simplicidade da ferramenta facilitou a inclusão das comunidades indígenas e dos 
agricultores, tornando-os parte integrante do processo de monitoramento e gestão ambiental. 

Outro desafio digno de referência foi a barreira linguística. Embora todos os envolvidos 
falassem português, as diferenças entre o português de Portugal e o do Brasil causaram 
dificuldades de comunicação, especialmente nos momentos iniciais do estágio. Adotei uma 
abordagem comunicativa mais pausada e ajustada, o que foi essencial para garantir a 
compreensão mútua e a colaboração eficaz entre a equipa portuguesa e a brasileira. Exemplo: 
a palavra restauração, que em Portugal também é sinónimo de zona de restaurantes, no Brasil 
é exclusivamente aplicada à recuperação. 

Ao longo do estágio, foram alcançados resultados significativos, desde o desenvolvimento da 
arquitetura do SIG até à capacitação dos utilizadores e a implementação de uma aplicação 
prática para a visualização e gestão dos projetos. A criação de mapas e a exportação de 
cartografia foram passos essenciais para comunicar os resultados dos projetos às partes 
interessadas, promovendo a conservação da biodiversidade na região. 

Em suma, este estágio foi uma oportunidade valiosa para aplicar e aprofundar os 
conhecimentos em tecnologias SIG voltadas para a gestão ambiental e para a promoção do 
desenvolvimento sustentável. As lições aprendidas e os desafios superados ao longo deste 
processo reforçam a importância da flexibilidade, da adaptação e da colaboração no sucesso 
de projetos complexos. O trabalho realizado contribuiu de forma tangível para os objetivos de 
preservação ambiental da FASB e da NGPTA Lda, promovendo um futuro mais equilibrado e 
sustentável para a região do Sul da Bahia. 
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Anexos 

Os mapas e materiais didáticos mencionados no texto estão disponíveis em arquivos 
separados. Essa abordagem permite uma melhor visualização dos detalhes, facilitando a 
compreensão e análise do conteúdo apresentado. Recomenda-se abrir cada arquivo 
individualmente para aproveitar a qualidade e clareza das informações. 

 

 

Figura 17 - Saída de Campo com o Prof.º  Dº Elfany Reis do Nascimento Lopes, utilização do sistema QField (06/2024, fotografia por 
Nicolau Silva) 
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Figura 18 - Visita ao viveiro (02/05/2024 fotografia do FASB) 
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Figura 19 - Visita de um Projeto em Santa Cruz Cabrália, após a aula prática de Google Earth e QField (07/05/2024 fotografia do FASB) 

 

Figura 20 - Aplicação ‘QField for QGIS’, para os Dispositivos Móveis  
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Figura 21 - Plugin QField Sync,do QGIS 
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Figura 22 - Encontro de Anual do FASB para submissão de projetos (25/05/2024 fotografia do FASB) 
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Figura 23 - Aula de utilização de drone na UFSB, ensinado por Prof.º Dº Elfany Reis do Nascimento Lopes (09/06/2024 fotografia do 
FASB) 
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Figura 24 - Layout Automático do QGIS 
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Figura 25 - Exercício de Capacitação, Estrada entre o Escritório e o Aeroporto de Porto Seguro 

 

Figura 26 - Tabela de Atributos na fase inicial 
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Figura 27 - Tabela de Atributos mais recente 

 

 

Material Didático e Tutorial (Anexo/Documento a parte): 

Introdução ao QGIS e QField para 
Trabalhos de Campo 

Capacitação de Colaboradores e Comunidades na Utilização de 
Ferramentas Geoespaciais 
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